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CHAPTER 1: REPORT WRITER OVERVIEW 
Training Objectives 

Actively participating during this chapter helps you learn: 
 

• The features and benefits of using Report Writer 
• The advantages and disadvantages of the different setup 

configurations available for Report Writer 
• How to use the Reports Dictionary 
• Basic terminology used in Report Writer 
• The difference between primary and secondary copies of reports 
• How to restrict access to reports using the security options within the 

Microsoft Dynamics™ GP application 
• The available printing and format options when generating reports in 

Microsoft Dynamics GP and Report Writer  
 

Introduction 
Welcome to Report Writer, an integral component of the Microsoft Dynamics GP 
financial management systems. Even if you have never used a computerized 
reporting application, you will likely find Report Writer both easy to learn and 
easy to use. Report Writer allows you to customize existing reports and create 
custom reports using data from the Microsoft Dynamics GP application. 
 
If you have used a graphics drawing program before, you will be familiar with 
many of the design tools you can use to design reports in Report Writer. Its 
simple yet sophisticated interface is intuitive and flexible, making it easy to 
create reports that can meet the needs of your business.  
 
Report Writer is available to everyone since it is purchased with the System 
Manager module. Report Writer does not require any additional installation; it is 
automatically installed when Microsoft Dynamics GP is installed.  
 
Report Writer can be accessed from the Tools menu on the main window of the 
Microsoft Dynamics GP application. Select Customize from the Tools menu to 
access Report Writer. The keyboard equivalent to access Report Writer is ALT + 
F9.  
 
You can access additional information about Report Writer from the Help menu 
in the Microsoft Dynamics GP application. When in the Report Writer 
application, a user's guide can be accessed by selecting the Printable Manuals 
menu option from the Help menu. 
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Features and Benefits 
Report Writer helps you create customized reports to meet specialized needs of 
your business. You can accomplish the following with Report Writer:  

Customize Microsoft Dynamics GP Reports 
Most Microsoft Dynamics GP reports can be modified to suit specialized needs 
or goals using Report Writer. You can create reports similar to the ones included 
with the application, but modified according to specific reporting needs. Since 
Report Writer is the same application used to create the reports included with 
Microsoft Dynamics GP, you can give all reports the same look and feel of the 
originals. Use fonts, colors and graphics to design the report's appearance to meet 
your specifications. 

Create Custom Reports 
Report Writer allows you to create reports that draw data from any area in the 
Microsoft Dynamics GP system. As with modified reports, you can make the 
report look exactly as desired, using fonts, color and graphics. 

Customize Reports for Individual Users 
Users can be assigned access to either an original report shipped with Microsoft 
Dynamics GP or its modified copy. Access to custom reports can be set by user 
class or by individual user. 

Print Reports 
All of the reports you modify or create with Report Writer can be printed within 
the accounting system or from Report Writer and can be exported, published, and 
printed in either graphics or text mode. 
 
Reports can be exported in four formats:  
 

• Text 
• Comma-separated values 
• Tab-delimited values 
• Hypertext markup language (HTML)  

 
These output formats allow the information in the report to be further modified 
and customized in many productivity applications such as spreadsheets, 
databases, Web browsers and graphics programs. 
 
Report Writer can create two types of printed output:  
 

• Graphics mode − For high quality output with font control, picture 
printing, and color output capabilities  

• Text mode − For fast output when printing speed is more important 
than the output format 
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Use Multiple Data Tables in a Report 
Report Writer can draw information from multiple data tables and include that 
information on the same report. This capability allows you to create reports that 
draw information from many different Microsoft Dynamics GP modules and 
series simultaneously. 
 
Tables that can be linked to any given table are predetermined, so linking is a 
simple process. Simply view the list of tables that can be linked and make your 
selections. In addition, you can define table relationships and determine which 
other tables can be linked by the type of relationship used. 

Create Restrictions 
Report Writer can create restrictions that limit the amount of information that 
appears on a report. This enables you to print only the information needed. 
Restrictions can be simple, such as listing only customers in a particular state, or 
as complex as necessary, listing only customers in that state who have purchased 
a given item within a given period of time. 

Create Calculations 
Report Writer allows you to create calculations to be printed on reports. These 
calculated fields can be based on data in any of the data tables, as well as a set of 
variables and mathematical functions, providing almost unlimited capabilities. 
Calculations can be as simple as adding the value of two fields or as complex as 
creating a calculation based on other calculated fields. 

Create New Sorting Methods 
You can sort reports by fields in any of the report's tables, whether or not the 
fields are part of the report. This capability allows you to focus on the part of the 
report that is most important, presenting the data in the order needed.  
 
Select whether to sort in ascending or descending order, which allows the 
creation of "top 10" reports, such as the customers with the 10 largest balances or 
any number or type of records. 

Limit Access to Reports 
The Security Setup window in Microsoft Dynamics GP System Manager allows 
you to specify whether users have access to each report, as well as whether they 
have access to each data table in the system.  
 
Users can create reports using tables that they do not have access to, but they 
cannot print the reports. Primary and secondary reports and their unique security 
options allow flexibility to the user when printing modified reports. 
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Using the Reports Dictionary 
All the resources used by the Microsoft Dynamics GP system, such as fields, 
tables, forms, windows, pictures and text, are stored in a single file − a 
dictionary. To ensure data integrity, each change made with Report Writer is 
saved in a separate dictionary file. Microsoft Dynamics GP uses the dynamics 
dictionary table (DYNAMICS.DIC) to store all of the information about itself.  
 
A new dictionary file (REPORTS.DIC) is automatically created when accessing 
Report Writer the first time. The reports you create, whether copying an original 
Microsoft Dynamics GP report or creating a custom report, are stored in that 
Reports dictionary. The Reports dictionary contains the information needed to 
store and print your modified reports.  
 
When modifying a Microsoft Dynamics GP report, you actually make a copy of 
it and modify the copy. The original report remains the same, and the modified 
copy is stored in the Reports dictionary. 
 
The Reports dictionary can be stored in one of two places: on each individual 
workstation or on the file server. The location you store the Reports dictionary is 
specified in the launch file (DYNAMICS.SET), which is in the application's 
folder on each workstation. 
 
The following illustration shows a few of the lines of content from a typical 
DYNAMICS.SET file for the Microsoft Dynamics GP application. This is not a 
complete file; it is just being used for illustration purposes. 
 

 
 
The launch file points to where the application looks for the appropriate 
dictionary. The Dynamics dictionary stores all the code necessary to run the 
application. The Forms dictionary stores modifications made using the Modifier 
application. The Reports dictionary stores modifications made using Report 
Writer. Currently, in this example, the application looks for the Reports 
dictionary on the local drive. This file can be edited using the Edit Launch File 
window within Microsoft Dynamics GP. 
 
Modified reports for products that integrate with Microsoft Dynamics GP are 
stored in a separate Reports dictionary for each product. The names and locations 
for these Reports dictionaries and the locations where they are originally installed 
are determined by the location listed in the launch file.   
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Storing Modifications at Workstations 
If you specify in the DYNAMICS.SET file to look locally for the Reports 
dictionary, Microsoft Dynamics GP looks in your application folder on the 
workstation for a Reports dictionary file when going into the Report Writer 
application.  
 
If Microsoft Dynamics GP does not find a Reports dictionary at that location, it 
creates one. This is how the Reports dictionary is created the first time Report 
Writer is accessed. If Microsoft Dynamics GP finds a Reports dictionary, that 
dictionary is used to store any changes made with Report Writer. 
 
In the following illustration, an administrator with access to the Report Writer 
(Workstation #1) can create modified and custom reports for users at 
Workstations #2 and #3 by copying that Reports dictionary (REPORTS.DIC) to 
each of those workstations' hard disks. The administrator then creates another 
Reports dictionary file with modified and custom reports especially for the user 
at Workstation #4: 
 

 
 
Storing the Reports dictionary on each workstation allows you to customize 
Microsoft Dynamics GP reports for each user. It also increases performance 
when printing modified reports since you do not have to access the file server to 
use the Reports.dic file. Storing the Reports dictionary also gives the flexibility 
of having different reports for each individual user in the Microsoft Dynamics 
GP system. If using multiple Reports dictionaries, keep in mind that users may 
create different reports in their Reports dictionaries.  
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If one user wants to print a report that is contained in another user's Reports 
dictionary, select one of the following options. 
 

• Transfer an individual report from one Reports dictionary to another 
Reports dictionary using the package file feature found by navigating 
to TOOLS→CUSTOMIZE→CUSTOMIZATION MAINTENANCE. 

• Edit the Microsoft Dynamics GP launch file to specify a different 
Reports dictionary. (From the Microsoft Dynamics GP Tools menu, 
go to SETUP→SYSTEM→EDIT LAUNCH FILE. Use the Edit Launch File 
window to specify the location of the Reports dictionary being used.)  

 
HINT: You can create several launch files, each containing a different Reports 
dictionary location, and use the appropriate launch file to start Microsoft Dynamics GP. 
Refer to the Microsoft Dynamics GP online help for information about using multiple 
launch files and about how to set up Report Writer to be single-user or multi-user. 

 
HINT: To create more than one Reports dictionary file, remove the existing file from its 
default location; a new file is created the next time you enter Report Writer. Changes 
stored in the original Reports dictionary file do not appear in Microsoft Dynamics GP 
until it is placed back in its default location. 

 

Storing Modifications on a Network 
If you specify in the DYNAMICS.SET file to look on the file server for the 
Reports dictionary, Microsoft Dynamics GP looks in the application folder on the 
file server for a Reports dictionary when switching into the Report Writer 
application. If Microsoft Dynamics GP does not find a Reports dictionary at that 
location, it creates one. If Microsoft Dynamics GP finds a Reports dictionary, it 
is used to store any changes made with Report Writer. 
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In the preceding illustration, an administrator with access to the Report Writer 
(Workstation #1) can create modified and custom reports for all users in the 
accounting system by setting access to modified and customized reports using 
system security. To set access to modified and any custom reports, enter the 
Microsoft Dynamics GP system and use either the User Class Setup or the 
Security Setup windows to grant access to the reports. 
 
HINT: If you store the Reports dictionary at a network location, be sure to use the Edit 
Launch File window to "point" each workstation to the location of the dictionary. 

 
In the preceding illustration, an administrator with access to the Report Writer 
(Workstation #1) can create modified and custom reports for all users in the 
accounting system by setting access to modified and customized reports using 
system security. To set access to modified and any custom reports, enter the 
Microsoft Dynamics GP system and use either the User Class Setup or the 
Security Setup windows to grant access to the reports. 
 
A major benefit of storing a Reports dictionary on the file server is that the file is 
easier to maintain, since changes made to reports are reflected for each user 
granted access to those reports. 
 
HINT: If the Reports dictionary is stored on a network drive, only one person can 
access the Reports dictionary at a time. 

 

Launching Report Writer 
Report Writer and Microsoft Dynamics GP are two separate applications that 
work together to produce reports. Report Writer draws the information from your 
Microsoft Dynamics GP system's data tables and prints the information on the 
reports.  
 
Report Writer allows you to take existing reports, modify them, and then print 
them using Report Writer or in Microsoft Dynamics GP. This provides flexibility 
when presenting financial information to internal and external customers of your 
company. 
 
All of the information in your system, regardless of the series or company, can be 
placed on reports and printed using Report Writer or Microsoft Dynamics GP; 
however, information can be pulled from only one company at a time. Using 
table links, information can be displayed from different tables on the same report. 
 
To switch to Report Writer, select Report Writer from the Customize option on 
the Tools menu or type ALT + F9. The Report Writer menu appears. To modify or 
create reports, click the Reports button and the Report Writer window appears, 
displaying all reports in the Microsoft Dynamics GP system.  
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HINT: You can also switch to the Report Writer application by printing an existing 
report to the screen within Microsoft Dynamics GP and selecting Modify Current 
Report (or use the keyboard equivalent of CTRL + F9) from the Customize option on the 
Tools menu or click Modify on the output tool bar. This switches you to the Report 
Writer application and also opens the Report Layout window for the current report. 

 
Original Microsoft Dynamics GP reports are stored in the DYNAMICS.DIC file 
and are displayed in the Original Reports list on the left side of the Report Writer 
window; modified and custom reports are stored in the REPORTS.DIC file and 
are listed on the right in the Modified Reports list. 

The Report Writer Main Menu 
When opening the Report Writer application in Microsoft Dynamics GP, the 
Report Writer's main menu looks like this: 
 

 
 
The menu bar includes operating system menu selections and menu selections for 
displaying information about Microsoft Dynamics GP resources and Report 
Writer online documentation. Macros also can be created and launched from the 
menu bar.  
 
Report Writer and Microsoft Dynamics GP are two separate applications. The 
File menu includes a link back to the Microsoft Dynamics GP application and 
also provides access to table, field, and window descriptions. These options are 
helpful for finding where data is located in Microsoft Dynamics GP. 
 
The main menu of Report Writer also includes a toolbar where you select to 
display information about Microsoft Dynamics GP data types, fields, tables and 
reports. The Reports button window is often referred to as the main window of 
Report Writer because this window is used to modify and create Microsoft 
Dynamics GP reports.  
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Refer to the following tables for additional information about each menu and 
toolbar option. 
 
Toolbar Functions 
 

 

Displays a list of all data types in the Microsoft Dynamics 
GP system. You can view information about a data type, 
change a data type, text and picture values, and change 
the format used by a data type. 

 

 

Displays a list of all fields in the Microsoft Dynamics GP 
system. You can view information about a field and 
change a data type used by a field. 

 

 

Displays a list of all tables in the Microsoft Dynamics GP 
system. You can display a selected table's definition and 
view information about the table. 

 

 

Displays the Reports window. This window displays all 
the reports in the application. You can insert original 
reports in the list of modified reports and then view the 
reports windows and each report's layout. 

 
Menu  Bar Report Writer Functions 
File Quit Report Writer by selecting Exit or Quit, or return to 

Microsoft Dynamics GP by selecting Microsoft Dynamics 
GP. Print a report of all dictionary resources by selecting 
Generate Resource Reports. A prompt asks for a file name 
and location for the report. 

Edit Place selected text on the clipboard by selecting Copy, or 
paste the contents of the clipboard in a report layout by 
selecting Paste. Remove objects by selecting Clear. 

Macro Macros allow you to record mouse clicks and keyboard 
entries and play them back at a later time. Refer to the 
System Manager training manual for additional 
information about how to use macros. 

Resources Display a list of selected Microsoft Dynamics GP 
resources. From the list, view additional information 
about a selected resource. For example, if you want to 
view a list of the formats Microsoft Dynamics GP uses, 
select Formats from the Resources menu. Select a format 
from the list and select Open to display the Format 
Definition window.  

Windows Select an open window in Report Writer. All windows 
currently open in the Report Writer appear in this menu.  

Help Use to access the online documentation available for 
Report Writer. 
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Select New to create a 
custom report 

Report Writer Window 
When opening Report Writer (select Customize, then Report Writer from the 
Tools menu), the Report Writer main window appears. Click the Reports button 
on the toolbar to make the Report Writer window appear.  
 
This window displays all Microsoft Dynamics GP reports and any modified or 
custom reports. Original Microsoft Dynamics GP reports are displayed in the 
Original Reports list on the left and modified and custom reports are listed on the 
right in the Modified Reports list, as shown below. The illustration also shows 
each button and its functionality. 
 
 
 

 
 
 
 
 
 
 
This window is often referred to as the main window of Report Writer. Custom 
reports are created by clicking New. Create copies of Microsoft Dynamics GP 
reports by selecting a report in the Original Reports list and clicking Insert or 
Copy. Copies can be customized using Report Writer. Copies of modified reports 
can also be created using the Duplicate button. The different types of reports are 
discussed on the following pages. 

Original Microsoft Dynamics 
GP reports are displayed in 
the Original Reports list. All 

reports other than originals − 
primary copies, secondary 
copies, and custom reports 

− are displayed in the 
Modified Reports list. 

Select Open to open 
any modified report 
and make changes. 

Select Delete to 
remove any 

modified report 
in the list. 

Select Insert to create 
a primary copy. 

Select Copy to create a 
secondary copy of an 

original report. 

Select Duplicate to create a 
secondary copy of a primary, 
secondary or custom report. 

Select Print to print a 
modified or custom 

report. 

Select Import to copy a 
report from another reports 

dictionary. 

Select Validate 
to verify that 

resources used 
on a report are 

valid. 

The Print Definition button 
allows you to print report 

settings to paper. 
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Types of Reports 
With Report Writer, reports can be created a number of different ways. As 
mentioned previously, you can make one copy of an original Microsoft 
Dynamics GP report and modify it. This copy is called the "primary copy," since 
only one can be created. If another copy of the report is needed create "secondary 
copies," which are copies of the original or primary copy.  
 
Custom reports can be created by starting from an empty report layout and 
making additional copies of those reports. All these reports can be printed from 
both Report Writer and the Microsoft Dynamics GP system. An exception to this 
is if the report uses a temporary table. If this is the case, you must print the report 
from Report Writer because temporary tables are not created or updated in 
Report Writer. 

Original Reports 
Original reports are those provided with your Microsoft Dynamics GP system. 
These reports were designed to give information that most businesses are likely 
to use. Reports provided with products that integrate with Microsoft Dynamics 
GP are also considered original reports, and can be modified the same as 
Microsoft Dynamics GP reports. 
 
HINT: The report names in the Original Reports list sometimes differ from the names 
used to refer to the same reports in Microsoft Dynamics GP.  

 
HINT: Several methods can be used to determine the name of the original report. You 
can print the report to the screen in Microsoft Dynamics GP; the name appears on the 
screen output window tool bar. Or with the report on screen, select Modify or CTRL + 
F9 to Modify the Current Report (this option is located on the TOOLS→CUSTOMIZE 
menu). The report layout automatically opens for the current report. The report name 
can also be found in the online help, or you can refer to the individual training manuals 
for each module that provide additional information about reports. 

 
Original reports are shown in the Original Reports list in the Report Writer 
window. Reports that have been modified as well as custom reports created using 
Report Writer appear in the Modified Reports list.  
 
If working with reports from another product, the lists display that product's 
original and modified reports. When switching to the Report Writer application 
from Microsoft Dynamics GP, you can make a selection as to which product's 
reports to modify.  
 
When using Report Writer to change original reports, start by making a copy of 
the original report you want to change. That copy can be a primary copy or a 
secondary copy. 
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Primary Copies  
When modifying a Microsoft Dynamics GP report by selecting the Insert button, 
you create its primary copy and make changes to the copy. 
 

 
 
Some restrictions apply to modifications of the primary copy: the main data table 
from which the report draws its information cannot be changed, although you can 
add tables by linking them to the main table. And although only a primary copy 
can be made, it can be substituted for the original report and printed in Microsoft 
Dynamics GP using the same sorting and restricting capabilities used with the 
original report.  
 
If you have already created several printing options sorted by different fields and 
including different parts of the original report, use the same options to print the 
primary copy. You must grant access to primary reports before they are available 
to users in Microsoft Dynamics GP. 

Secondary Copies 
To make several copies of an original Microsoft Dynamics GP report, you can 
make secondary copies as well as primary copies. Secondary copies have a 
different name than the original Microsoft Dynamics GP report and can be more 
extensively modified. Multiple secondary copies can be created. Microsoft 
Dynamics GP users automatically have access to print secondary reports. 
 

 
 
Secondary copies can be printed using Microsoft Dynamics GP, but without the 
same sorting and restricting options used with Microsoft Dynamics GP reports 
and primary copies. They can be printed by selecting the Customized option 
from the Reports button on the Microsoft Dynamics GP toolbar, but the sorting 
and restricting of the report must be done within Report Writer.  
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You can make multiple secondary copies and modify each of them as desired. 
For example, if you frequently need to print a report sorted in three different 
ways, you can create three different versions of the report and create a different 
sorting method for each. 
 
HINT: You cannot make secondary copies of reports that use temporary data tables. 
The Copy and Duplicate buttons are dimmed for original reports that use a temporary 
table. 

Custom Reports 
With Report Writer, you can create reports completely from scratch, designing 
them according to your particular specifications. You can make additional copies 
of these custom reports as well. Microsoft Dynamics GP users automatically 
have access to custom reports. These are printed by selecting Customized from 
the Reports button. 
 

 
 

Imported Reports 
Imported reports are transferred from another Reports dictionary. If someone else 
has created or modified a report based on the same dynamics dictionary 
(DYNAMICS.DIC) you are using, simply copy their report to your Reports 
dictionary − do not re-create the report in your reports dictionary 
(REPORTS.DIC). 
 
The Reports dictionary that you are copying from (also called the source 
dictionary) can contain primary copies, secondary copies and custom reports. The 
reports you import from the source dictionary retain the properties associated 
with the report being copied. For example, primary copies in the source 
dictionary work like primary copies in the destination dictionary. Similarly, 
secondary copies still work like secondary copies. 
 
It is important that both the source dictionary and the destination dictionary be 
based on the same version of the dynamics dictionary. If they are not, the reports 
may not be imported correctly. Use the Customization window to import and 
export reports between dictionaries. This is the recommended option when using 
Release 6.0 or later of Microsoft Dynamics GP. 
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Buttons on Report Writer Window 
 
Button Functions 
Insert Make a primary copy of a Microsoft Dynamics GP report by 

highlighting the original Microsoft Dynamics GP report to 
copy and selecting Insert. This button applies to reports in 
the Original Reports List. 

Copy Make a secondary copy of an original Microsoft Dynamics 
GP report by highlighting the original Microsoft Dynamics 
GP report to copy and selecting Copy. This button applies to 
reports in the Original Reports List. It is dimmed if the 
original report does not allow a secondary copy to be made.  

New Create a custom report by selecting New. If this option is 
selected, the starting point is a blank report. 

Open Make changes to any modified report by highlighting the 
report to change from the Modified Reports list and 
selecting Open. This button applies to reports in the 
Modified Reports list. 

Delete Delete any modified report by highlighting the report to 
delete from the Modified Reports list and clicking Delete. A 
message displays warning you that all changes to the report 
will be removed. Click OK to remove the modified report. 
This button applies to reports in the Modified Reports List. 

Duplicate Create a secondary copy of a primary, secondary or custom 
report by highlighting the report and clicking Duplicate. 
This button applies to reports in the Modified Reports List. 
It is dimmed if the original report does not allow a 
secondary copy to be made. 

Print Print a modified or custom report from this window by 
selecting the report from the Modified Reports list and 
clicking Print. This button is dimmed if the selected report 
uses a temporary table (it must be printed from Microsoft 
Dynamics GP). 

Import Copy a report from another Reports dictionary by selecting 
Import. It is recommended that you use the Customization 
Maintenance options if using R6.0 or later. 

Validate Verify that the selected report contains valid references to 
table fields by selecting Validate. Validate reports after 
installing a Microsoft Dynamics GP update. The Validation 
Results window displays messages that indicate whether the 
report contains invalid references.  

Print 
Definition 

Click Print Definition to print a report with text 
descriptions of your report definition including calculation 
fields, restrictions, and layout positioning. 
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Report Writer Security 
After creating a modified or custom report, specify which Microsoft Dynamics 
GP users may use the report before the reports can be printed from the Microsoft 
Dynamics GP system. A user must have access to the original report before they 
can print the primary copy. If access has been granted to the primary copy, then 
the primary copy is printed, not the original. 
 
Secondary copies and custom reports can be used in addition to or instead of 
original reports and primary copies. All users have access to secondary copies 
and custom reports as soon as the reports are created. If you do not want some 
users to print the reports, deny them access.  
 
Access for individual users and for user classes is set in the Security Setup and 
User Class Setup windows in the Microsoft Dynamics GP system. Some of your 
reports may contain sensitive information or may not be relevant to the tasks 
some employees perform. In either case, you may want to deny access to some 
reports. 

Granting Access to a Report 
You must set access to a primary copy to print it in Microsoft Dynamics GP. 
Primary copies of a report are printed instead of the original report. All secondary 
copies, as well as custom reports, can be printed in Microsoft Dynamics GP 
without first setting access to them. 
 
HINT: You must have access to the original report to grant access to the primary copy. 

 

Primary Copies 
To print a primary copy from the Microsoft Dynamics GP system, you must 
substitute it for the original report by setting access to it for each class or 
individual user who will be printing the report. You may not want all users to 
have access to every report, since some reports contain sensitive information, 
such as account balances or passwords.  
 
By default, users will not have access to primary copies of reports. Grant access 
to users using the Security Setup or User Class Setup windows. Each user can 
have access to only one version; however, they can always return to the original 
report if necessary. This can be done by removing access to the primary copy. 
 
HINT: Some reports, like posting journals, use temporary tables to generate some of the 
information printed on them. Since the Microsoft Dynamics GP system must create these 
temporary tables as part of the process of printing the report, these reports cannot be 
printed from Report Writer. You can still modify the report, but must use the Microsoft 
Dynamics GP system to print it. 
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Complete the following steps to set access to reports: 
 

1. Verify that users who print the primary copy have access to its 
original version. Select TOOLS→SETUP→SYSTEM→SECURITY OR USER 
CLASSES to open the Security Setup or User Class Setup windows. 

2. Select the appropriate user or class and the company, if using the 
Security Setup window. 

3. Select Reports as the Type and specify the appropriate series. If the 
original report, displayed in the Access List, has an asterisk next to 
it, access has been granted; if not, double-click on it to grant access. 

4. Select Modified Reports as the Type and select the appropriate 
series. Double-click on the primary copy to grant the user or user 
class access to it, instead of the original report. Select Custom 
Reports to access security options for secondary and custom reports. 

 Once you have substituted a primary copy for its original, the 
primary copy is printed in the same report window as the original 
and can be printed using the same printing options. Secondary copies 
can be printed from the Custom Reports window.  

Secondary Copies 
Secondary copies of reports can be used in addition to, or instead of, an original 
report or its primary copy. You do not need to set access to these reports unless 
you want to deny some users, or a group of users, access to the reports. By 
default, users have access automatically to secondary copies of reports.  
 
You may want to set user access to data tables, rather than each report. When 
denying a user access to a data table, they can create reports using the table, but 
cannot print the report.  

Previewing a Report (Optional) 
To ensure that the report appears the way you intended when it is printed, 
preview the report by printing it and displaying it on the screen. If the report 
appears with only text and graphic elements, there is no data in your data tables 
to be printed on the report.  
 
If printing a graphics report, the graphics may not appear in the window, but are 
printed correctly to the printer or a file. 
 
Highlight the report name in the Modified Reports list and click Print. The 
Report Destination window appears; check to be sure that only Screen is 
selected, and click OK. The Screen Output window appears, and, after the report 
has been generated, it appears in the window. Scroll to view the entire report, if 
necessary. 
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Printing Modified and Custom Reports 
Most reports, whether modified or custom, can be printed using Report Writer or 
the Microsoft Dynamics GP system. However, only the primary copy of an 
original report can be sorted and restricted using the same Microsoft Dynamics 
GP windows used to print the original.  
 
If substituting the primary copy of a report for its original, it appears in the same 
reports window as the original and can be printed using the same options. 
However, secondary copies and custom reports can be sorted and restricted only 
in Report Writer. When these reports are printed using the Microsoft Dynamics 
GP system, they are printed according to the settings made in Report Writer. 
 
HINT: You cannot print custom or modified reports from the Microsoft Dynamics GP 
system if another user is currently accessing Report Writer. Only one user can use 
Report Writer at a time (unless users are accessing different reports dictionaries). 

 
When printing reports using the Microsoft Dynamics GP system, the reports are 
printed using data for the current company. When printing using Report Writer, 
the data is drawn from the company you used before switching to Report Writer. 
To print reports from Report Writer, select the report in the Modified Reports list 
in the Report Writer window and click the Print button. 
 
HINT: Microsoft Dynamics GP reports that use temporary tables (like posting 
journals) cannot be printed from Report Writer. The Print button is dimmed. You can 
still use Report Writer to modify them, but must print them within the Microsoft 
Dynamics GP system.  

 
To print primary copies from Microsoft Dynamics GP, first set access to the 
primary copy. Then use the same report windows used to print the original 
reports. To print secondary copies from Microsoft Dynamics GP, use the Custom 
Reports window (Select Reports and Customized). 

Other Printing Options 
Exporting Reports 
Export any report by sending it to an export file, regardless of whether you are 
using Report Writer or Microsoft Dynamics GP to print it. The file format 
selected depends on how you use the file. The file format can be Text, Comma-
Delimited, Tab-Delimited or HTML. If the read/write version of Adobe Acrobat 
is installed on your machine, you can also export files in a PDF format. 

Copying Reports 
An alternative to exporting is printing the report to the screen and copying it 
using standard copy-and-paste procedures. This technique may be useful if you 
want to paste it into a document without exporting it. The report appears in the 
document in tab-separated format. 
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Publishing and Mailing Reports 
Microsoft Dynamics GP allows publishing reports and mailing reports via MAPI 
(Microsoft's Mail Application Program Interface) when printing reports to the 
screen. Refer to the System User's Guide for additional information. 

Mailing Reports 
To mail a text report to another user via MAPI, click the Send To button. Enter 
the mail address in the dialog box that appears and click Send. The report is sent 
as an attachment file to the mail destination selected in the dialog box. The 
report's Report Writer name appears in the subject line of the mail message.  
 
HINT: If your operating environment does not have MAPI enabled mail system, the 
Mail button is not available. In this case, you can send the report to a file, and then 
copy the file into your mail application. Mail reports as text files or in PDF format if 
you have the read/write version of Adobe Acrobat loaded.  

 
If using a 32-bit operating environment with MAPI capabilities, you can send 
reports via MAPI to anyone who is currently configured for a MAPI mailbox. 
The attachment file is saved with a .txt extension. The person receiving the report 
can use the application that is associated with this extension in Windows to view 
the file. 

Review Types of Reports: 
 
Report 
Type 

Button 
to Create

# 
Copies 

Set 
Access 

Print From Report 
Options 

Primary Insert 1 Must 
Grant 

Microsoft 
Dynamics GP 
and Report 
Writer 

Microsoft 
Dynamics GP 
and Report 
Writer 

Secondary Copy or 
Duplicate

No limit Have 
Access 

Microsoft 
Dynamics GP 
and Report 
Writer 

Report Writer 
only 

Custom New No limit Have 
Access 

Microsoft 
Dynamics GP 
and Report 
Writer 

Report Writer 
only 

 
*Imported reports work similar to the primary copies, secondary copies, or 
custom reports they are based upon. 
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Lab 1.1 − Creating Copies 
In this exercise, you create three modified reports:  
 

• A primary copy of the Trial Balance Detail report 
• A primary copy of the Blank Invoice Form 
• A secondary copy of the Blank Invoice Form  

 
The goals of this exercise are to introduce the differences between primary and 
secondary copies of reports and to introduce the differences between reports that 
use temporary tables and reports that do not. 

Creating Primary Copies 
 

1. After entering the Microsoft Dynamics GP system and selecting the 
lesson company and a lesson user, select Report Writer from the 
Customize option on the Tools menu. The Report Writer main menu 
appears.  

2. Click the Reports button to open the Report Writer window where 
all original and modified reports are listed. Highlight Trial Balance 
Detail in the Original Reports list. 

 Why is the Copy button dimmed? 

 
 
 
 
 

3. Click the Insert button to insert the report into the Modified Reports 
list. Highlight the Trial Balance Detail report in the Modified 
Reports list. 

 Why are the Duplicate and Print buttons dimmed? 

 
 
 
 
 

 What happens if you try to insert another copy of the report? 
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Creating Secondary Copies 
 

1. After entering the Microsoft Dynamics GP system and selecting the 
lesson company and a lesson user, select Report Writer from the 
Customize option on the Tools menu. The Report Writer main menu 
appears.  

2. Click the Reports button to open the Report Writer window where 
all original and modified reports are listed. Highlight the Blank 
Invoice Form in the Original Reports list. 

 Why are both the Insert and Copy buttons available? 

 
 
 
 

3. Click the Insert button to insert the report into the Modified Reports 
list. Highlight the Blank Invoice Form report in the Modified Reports 
list. Note that the Duplicate and Print buttons are available for use 
with this report. 

4. Click the Copy button to copy the Blank Invoice Form into the 
Modified Reports list. Name the report "Blank Invoice Form- copy" 
and click OK. 

 Why did you need to give the copy of the Blank Invoice Form a 
unique name? 

 
 
 
 
 

 Are you able to create additional copies of the report using the Copy 
button? 

 
 
 
 
 

 Are you able to create additional copies of the report using the 
Duplicate button? 
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Lab 1.2 − Granting Access and Printing Primary Copies 
Company: Fabrikam, Inc. 

 
Background Information: A user can print primary reports in Microsoft 
Dynamics GP or Report Writer unless the report uses a temporary table. If the 
report uses a temporary table, the report must be printed within Microsoft 
Dynamics GP to ensure the temporary table is created before the report is printed. 
Security access must be granted to the primary copy of the report to ensure that 
the original report will be replaced with the primary copy. In the first part of this 
section, you work with the Trial Balance Detail report, and then you look at the 
Blank Invoice Form.  
 
Scenario: Since you have decided to modify the Trial Balance Detail Report and 
the Blank Invoice Form, you need to grant access to the modified reports before 
printing them from Microsoft Dynamics GP. Grant access to the reports to your 
User ID and print the reports. To begin this exercise, open Report Writer. 

Challenge Yourself!  
Trial Balance Detail Report 
Granting Access to the Primary Copy 
Grant the current user access to the Trial Balance Detail.  

Printing the Primary Copy in Microsoft Dynamics GP 
 

1. Make the following selections in the Trial Balance Report Options 
window: 

 
Option Option1 
Include Posting Accounts 
Sort by Account (Segment 2) 
Subtotal by No Subtotals 
Year Open and 2007 
Ranges Date 
From Enter Date and 01/01/07 
To Enter Date and 01/31/07 

 
2. Insert the Date Range restriction into the Restrictions box. 

3. Print the report to the screen; use the Destination button to verify 
that the report prints to the screen only. 
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Blank Invoice Form 
Granting Access to the Primary Copy 
Grant the current user access to the Blank Invoice Form. 

Printing the Primary Copy in Microsoft Dynamics GP 
 

1. Bring up a document in the Invoice Entry window.  

2. Verify that the Invoice Format is Blank Paper.  

3. Print the report to screen. 

 Using the Screen Output window, how can you determine the Report 
Writer name for a Microsoft Dynamics GP report? 
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Lab 1.2 − Granting Access and Printing Primary Copies 
Company: Fabrikam, Inc. 

 
Background Information: A user can print primary reports in Microsoft 
Dynamics GP or Report Writer unless the report uses a temporary table. If the 
report uses a temporary table, the report must be printed within Microsoft 
Dynamics GP to ensure the temporary table is created before the report is printed. 
Security access must be granted to the primary copy of the report to ensure that 
the original report will be replaced with the primary copy. In the first part of this 
section, you work with the Trial Balance Detail report, and then you look at the 
Blank Invoice Form.  
 
Scenario: Since you have decided to modify the Trial Balance Detail Report and 
the Blank Invoice Form, you need to grant access to the modified reports before 
printing them from Microsoft Dynamics GP. Grant access to the reports to your 
User ID and print the reports. To begin this exercise, open Report Writer. 

Need a Little Help?  
Trial Balance Detail Report 
Granting Access to the Primary Copy 
 

1. Return to the Microsoft Dynamics GP system. 

2. Access the Security Setup window. 

3. In the Security Setup window, make the following selections: 

 
User Select the current User ID 
Company Select the lesson company 
Product Microsoft Dynamics GP 
Type Modified Report 
Series Financial 

 
4. Grant the current user access to the Trial Balance Detail.  

Printing the Primary Copy in Microsoft Dynamics GP 
 

1. From the Financial Reports menu, select Trial Balance.  

2. Create a new option to use when printing this report.  
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3. Make the following selections in the Trial Balance Report Options 
window: 

 
Option Option 1 
Include Posting Accounts 
Sort by Account 
Subtotal By No Subtotals 
Year Open and 2007 
Ranges Date 
From Enter Date and 01/01/07 
To Enter Date and 01/31/07 

 
4. Insert the date restriction into the Restrictions list.  

5. Ensure the destination for the report is the screen. Make sure the 
Printer check box is not selected. 

6. Save your new option.  

7. Close the Trial Balance Report Options window. 

8. In the Trial Balance Report window, select Option 1 from the 
Options list and insert it into the Print List.  

9. Print the report to the screen.  

10. After the report has finished printing, close the Screen Output and 
Trial Balance Report windows. 

Blank Invoice Form 
Granting Access to the Primary Copy 
 

1. Access the Security Setup window. 

2. In the Security Setup window, make the following selections: 

 
User Select the current User ID 
Company Select the lesson company 
Product Microsoft Dynamics GP 
Type Modified Reports 
Series Sales 

 
3. Grant the current user access to the Blank Invoice Form. 

4. Save your selections. 
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Printing the Primary Copy in Microsoft Dynamics GP 
 

1. From the Sales Transactions menu, select Invoice Entry.  

2. Click on the previous record browse button in the Invoice Entry 
window to bring up a document. If you have not made any previous 
entries in the Invoicing module, the document displayed is IVC23. 

3. Select Extras and Options and then Document Format from the menu 
(on the menu bar) to open the Invoice Document Formats window.  

4. Close the window. 

5. Click the Print button.  

6. Ensure the Destination for the report is the Screen.  

7. Close the Report Destination window and print the report. 

8. After viewing the report, close the Screen Output and Invoice Entry 
windows. 

 Using the Screen Output window, how can you determine the Report 
Writer name for a Microsoft Dynamics GP report? 
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Lab 1.3 − Secondary Copies 
Company: Fabrikam, Inc. 

 
Background Information: A user can print secondary reports in Microsoft 
Dynamics GP or Report Writer. The user does not need to grant access to a 
secondary copy of a report because the original report is not being replaced; the 
secondary copy is printed from a different location within Microsoft Dynamics 
GP.  
 
Scenario: The modified Blank Invoice Form is being used by Operations for 
invoicing. The Sales and Marketing department would like to use this invoice 
format also, but they need to make a few minor changes. Since Sales and 
Marketing only issue occasional invoices, you have decided to use the secondary 
copy of the Blank Invoice form that has previously been created. (Blank Invoice 
Form − copy) 

Challenge Yourself! 
Verifying Access to the Secondary Copy 
Verify that you have access to the Blank Invoice Form − copy.  

Printing the Secondary Copy in Microsoft Dynamics GP 
Print the Blank Invoice Form − copy to the screen. 



Microsoft Official Training Materials for Microsoft Dynamics ™ 
Your use of this content is subject to your current services agreement 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Chapter 1: Report Writer Overview 

Page 35 

Lab 1.3 − Secondary Copies 
Company: Fabrikam, Inc. 

 
Background Information: A user can print secondary reports in Microsoft 
Dynamics GP or Report Writer. The user does not need to grant access to a 
secondary copy of a report because the original report is not being replaced; the 
secondary copy is printed from a different location within Microsoft Dynamics 
GP.  
 
Scenario: The modified Blank Invoice Form is being used by Operations for 
invoicing. The Sales and Marketing department would like to use this invoice 
format also, but they need to make a few minor changes. Since Sales and 
Marketing only issue occasional invoices, you have decided to use the secondary 
copy of the Blank Invoice form that has previously been created. (Blank Invoice 
Form − copy) 

Need a Little Help? 
Verifying Access to the Secondary Copy 
 

1. Select the Security option from the System Setup menu. 

2. In the Security Setup window, make the following selections: 

 
User Select the current User ID 
Company Microsoft Dynamics GP 
Product Microsoft Dynamics GP 
Type Custom Reports 
Series Sales 

 
 Note that you already have access to the Blank Invoice Form − copy.  

Printing the Secondary Copy in Microsoft Dynamics GP 
 

1. Select Customized from the Reports menu.  

2. Make the following selections in the Custom Reports window: 

 
Product Microsoft Dynamics GP 
Series Sales 

 
3. Insert Blank Invoice Form − copy into the Print List. 

4. Ensure that the Blank Invoice Form − copy only prints to the screen. 

5. Print the report to the screen. 
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Test Your Knowledge − Report Writer Window Components 
Record the name of each of the numbered options and an explanation of what the 
button or field does in Report Writer. 
 

 
 
 
1. 
 
 
2. 
 
 
3. 
 
 
4. 
 
 
5. 
 
 
6. 
 
 
7. 
 
 
8. 
 
 
9. 
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Test Your Knowledge − Report Writer Overview 
 

1. What type of report requires you to grant access to the report before 
you are able to print it? Why is this required? 

 

 

 

2. Why are you not able to print a report that uses a temporary table in 
Report Writer? 

 

 

 

3. Why are you not able to create a secondary copy of a report that uses 
a temporary table? 

 

 

 

4. For which types of reports are you not allowed to create report 
options in Microsoft Dynamics GP? 
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Conclusion 
Report Writer Overview 
Some key points to remember from this chapter include: 
 

• Report Writer allows you to create custom reports. 
• Report Writer allows the customization of existing Microsoft 

Dynamics GP reports. 
• The Reports dictionary stores modifications that are made to 

Microsoft Dynamics GP reports. 
• A Reports dictionary can be local or shared on a network drive. 
• Report Writer can be launched from the Tools menu by selecting 

Customize. 
• Resources for locating tables and fields in the application are 

accessible from the Report Writer menu. 
• Copies of existing reports are created in the Reports dictionary. 
• The Dynamics dictionary stores original Microsoft Dynamics GP 

reports. 
• A primary copy of a report allows you to print it in place of the 

original within the application. 
• One primary copy of a report can be created. 
• A secondary copy of a report can only be printed from Report Writer 

or the customized reports selection in Microsoft Dynamics GP.  
• An unlimited number of secondary copies of a report can be created.  
• The New button should be used to create a blank custom report. 
• Security access for primary copies of a report must be granted to 

users. 
• Security access for secondary copies is granted automatically; if a 

user should not have access, take away access to those users. 
• Reports that use temporary tables can not be printed in the Report 

Writer. 
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Quick Interaction: Lessons Learned 
Take a moment to write down three Key Points you have learned from this 
chapter: 
 
1. 

 

 

 

 
 
2. 

 

 

 

 
 
3. 
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